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Getting Started with Artstor
Artstor is a database of images for teaching and research developed by the Mellon Foundation,
made available to everyone in the NYU community by license through Bobst Library. To use Artstor, you
need an e-mail account, a computer with an Internet connection, and a little patience. The following
document describes the basic ways you might use Artstor’s most current version; specialized functions
are described in detail in Artstor’s on-line “help” documentation (which can be found at
http://help.artstor.org/wiki/index.php/Main_Page). Any questions that arise can be addressed to IFA’s
Digital Media Services Manager, Jenni Rodda, jenni.rodda@nyu.edu. Artstor workshops and tutorials are
taught at IFA throughout the academic year, as needed and requested by the community. Introductory
instruction is also available on YouTube (see http://www.youtube.com/Artstor for the instructional videos
available there. “Export to PowerPoint” is particularly helpful. The YouTube link is also available on
Artstor’s landing page; click on the “Teaching & studying with Artstor” link.)
Please remember that NYU licenses access to Artstor under very particular conditions. It is your
responsibility as an end-user to make sure you are using Artstor’s images and functionality within the
terms and conditions of that license (NYU is the licensing entity, not you personally). For more
information, click the “Terms and Conditions of Use” link at the bottom left of Artstor’s home page.
Before you begin, make sure your computer is Java-enabled, that your Flash software has been
updated, and that pop-ups are allowed from the Artstor site. This solves the most common problems
encountered while connecting to Artstor. When you are ready to use Artstor on your home computer,
there are very clear end-user system requirements posted on its home page, at
http://www.artstor.org/using-artstor/u-html/requirements.shtml . Check there if you are not sure whether
your home computer is Artstor-ready. Be aware that Artstor’s image files can be rather large; how quickly
they load for you will depend on the speed of your connection and the traffic on Artstor’s servers during
your visit to their site.
To register as a user, and to start using Artstor:

•

Connect to Artstor, from any computer within the NYU network or registered through the NYU
proxy server or VPN, at www.artstor.org. The home page has a button at the top right marked
“Artstor Digital Library. Enter Here.” Click there. The next screen you will see is the main
access page for the database. Artstor works with both PCs and with Macs, through a variety of
browser environments, and is accessible on all computers at IFA/CC.
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•

Register as a user. Although you can browse for images from any NYU computer without
registering, you have much greater functionality once you do. You MUST register from a
computer within the NYU network, although you do not have to use your NYU e-mail address as
part of the registration process. You can register either from a computer on campus, or from
your own computer, if it has been configured to run through NYU’s proxy server or VPN (for
more about authenticating yourself as an NYU user while you are off-site, see
http://www.nyu.edu/its/nyunet/offcampus/.) We also recommend that you use your NYU e-mail
address to register, so that if there are ever difficulties connecting to Artstor that are related to
your e-mail account, you can get help more easily. In the upper right corner of the main access
page, there is a register/log-on box. Click “Not registered?” then follow the directions in the
dialog box. You are asked to enter your e-mail address, twice, and a password you make up for
yourself, twice; you may also be asked what school you attend (this is part of Artstor’s on-going
security overlay study, that will eventually result in single sign-on privileges. That’s not ready just
yet.) Artstor’s dialog boxes are sometimes click-through rather than tab-through interfaces,
which can be annoying if you are used to the latter (it seems that the dialog boxes are clickthrough on PCs and tab-through on Macs). The next time you visit Artstor after registering, click
the “log on” button, and follow the directions in the resulting dialog box. A note on remote (e.g.,
off-campus) access: once you have registered as a user, Artstor allows you remote access for
120 days from any computer, anywhere, whether or not it is running through the NYU proxy
server or VPN. After that 120 days is up, you will need to re-authenticate yourself to their
servers, from an NYU-networked computer. If that is not possible, try setting up NYU’s proxy on
your home computer instead; the proxy authenticates you to Artstor no matter where your
personal computer happens to be located. For more on remote access, see
http://www.artstor.org/using-artstor/u-html/remote-access.shtml .

•

Start browsing. You can start searching immediately using the search box at the left of the main
entry page. Note that there is a drop-down menu just below the keyword search box—you need
to tell the database which collection you want to search (or that you want to search all collections
simultaneously), before clicking the “search” button. Be careful what you ask for: searching with
a general term (like “painting”) may bring up more information than you can browse easily.
Artstor will only bring up the first 1000 hits in a general search. Parts of the NYU Digital Image
Collection are also available through Artstor, and can be searched simultaneously with Artstor’s
various collections. Look in the drop-down menu under the main “search” box for the link to the
Institute’s collection. Artstor allows general browsing by both geography (“Afghanistan,”
“Zimbabwe”) and image classification (“Gardens and Landscapes,” “Maps, Charts, and Graphs”),
terms that can be combined to narrow your search very quickly and efficiently, in addition to the
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names of the individual collections represented. Under “browse” on the main search page, try
clicking through the “geography” and “classification” listings for examples.

•

Build an image group. Once you have initiated a search and retrieved results, a virtual lightbox
of images will appear. Clicking on the caption below each image brings up whatever textual
information Artstor has on file; clicking on the image itself enlarges the image, and makes it
possible to zoom, pan, and rotate the image. If you wish to select an image for separate use,
click on its thumbnail. The frame will turn ochre (to unselect, click again, and the frame returns
to neutral). You may select as many images as you wish, on as many pages as you wish.
When you have selected the images you want to save, go to the button at the top of the lightbox
screen labeled “Organize”. Within the drop-down menu is the choice “Save selected images to.”
Click there, and choose the correct variant of “group” for your purposes. Another dialog box
appears, asking you to create a folder, and a group title. You can append, overwrite, or create a
new group, and you can ask Artstor to immediately open the group in a separate window. Don’t
forget to click “SAVE” when you’re done!
Image groups allow you to work with a selection of images you set aside for yourself, name in a

way that is meaningful to you, place in any order you like, and annotate in any way you wish. Image
groups can also be downloaded in full through Artstor’s proprietary software, the “Offline Image Viewer”
(OIV), for presentation purposes. Image groups may also be downloaded in PowerPoint-ready format
(1024 on the long side) to your desktop—or directly into PPT. They may also be downloaded, as a group,
in a Zip file, directly to your desktop. Those icons appear at the upper right of the lightbox screen when
you have an opened group.
Once you have created an image group, it “lives” on Artstor’s servers, in a partition accessible
only by you. The group will stay intact until you change or delete it (or until NYU changes its license with
Artstor, or you no longer have access to an NYU-networked computer). When an image group is open on
the screen, you can change the order in which the images appear by going to the tool bar, clicking on
“Display Options,” then on “sort displayed images by.” You might also re-order your group by dragging
and dropping any image next to any other image on the virtual lightbox screen. When you’re done, go
back to the “Organize” button, and click “Save Image Group.” You will be prompted to save the changes
you made. If you download a group you have rearranged in the Artstor database environment into the
OIV or PPT, the group will download in the order in which it was last saved.
In any screen in which images appear, you can enlarge (zoom, pan, rotate) and pull up any
information Artstor has about that image. Click on an image, and it will enlarge (half the screen will grey
out, and you may see a “percentage loaded” bar across the top of the image window; how long it takes to
download depends on the size of the image file and the speed of your network connection). Once the
enlarged image is on your screen, there will be two rows of icons at the bottom of the new window. Click
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the “plus” sign to zoom in, the “minus” sign to zoom out, and the icon of the small square to return the
image to its original size and position. When an image has been enlarged, a slide-sized reference image
appears in the bottom right corner of the new window. Zooming in creates a red outline on the reference
image; dragging the red outline within the reference image allows you to move the area of the image
being enlarged in the main part of the window.
To the right of the zoom in, zoom out, and reset icons, are three “mode” icons. The first, “zoom
mode,” allows you to create your own customized details. Click on “zoom mode,” then use the cursor to
“draw” a box around the part of the image you wish to enlarge. The second, “pan mode,” allows you to
move around the image once you have enlarged a section, by clicking/holding, and moving the cursor
around in the enlarged image. The third, “rotate mode,” allows you to rotate the selected image in any
direction (although the orientation of the thumbnail reference image does not change). The zoom and
pan features continue to function, even if the image has been rotated. (N.B.: An image downloaded into
the OIV reverts to its original size and orientation. Customized details print out, and will download to your
desktop, but do not download into the OIV. You can easily recreate them in the OIV, on the fly.)
Clicking the printer icon will allow you to print out a low-resolution version of the image, and all its
related descriptive text; you will get two pages of printout, one for the image and one for the text. If you
have created a detail when you click “print,” what prints out on the image page is whatever actually
appears on the screen. Click the “save” icon, and Artstor will allow you to download the image (at PPTready resolution) to your hard drive, stick drive, CD, or other portable media.
At the very bottom of the enlarged image window is another row of icons. Click the “full screen”
icon to make the image as large as possible (or, conversely, to return it to its original size). Click the “list”
icon to see the titles of every image in your image group—click on a title in the list, and that image
enlarges on the screen. Click the “information” icon to see all descriptive data associated with that image.
At the lower right edge of the image toolbar are three text buttons: one allows you to hide the
tombstone caption in the lower left; one takes you to Artstor’s error report form. If you find an error, click
there, and follow the directions on the resulting screen. Your comments on what needs to be fixed are
forwarded to Artstor’s metadata staff. The third brings up Artstor’s terms and conditions of use.
In the lightbox screen, clicking on the caption to any image pulls up its related description.
Descriptive information in Artstor varies widely; you will find that the “Image Gallery” (drawn originally from
the slide library at the University of California/San Diego, and found within the “Artstor Slide Gallery”) has
the most cursory textual information, and images of the most varied quality. The images in the “Illustrated
Bartsch,” in contrast, are frequently well-cataloged, with lengthy descriptions and interpretations in
addition to basic source data.
Across the top of the data screen (reached by clicking on the caption to a thumbnail) are several
tabs. The second tab, “file properties,” gives you the technical specifications of the image—including its
perpetual URL, which can be cut-and-pasted into another document if you need it. The third tab,
“personal notes,” allows you to annotate for yourself any image you have selected. Those personal notes
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are available and visible only to you. If you have arranged for instructor-level privileges, a fourth tab,
labeled “instructors notes,” will be active. Notes you write under the “instructors notes” tab are available
for general viewing by your students (“personal notes” are not). To arrange for instructor level privileges
within NYU’s Artstor license, contact Tom McNulty (tom.mcnulty@nyu.edu), NYU’s Art Librarian and
primary Artstor administrator (Tom can also be reached via a link on the main Artstor database page; look
for the “E-mail your institutional contact” under “Questions?” on the main page). A note on teaching with
Artstor: if you teach at an Artstor-subscribing institution other than NYU, you must register through that
institution’s license, and initiate local instructor-level privileges, for your students there to have access to
your Artstor groups and instructor’s notes. Questions about transferring image groups from one
institutional license to another should be sent to Artstor’s user services office (userservices@artstor.org) .
Don’t hesitate to use the “help” tab! Artstor has a great deal of detailed information available for
reference and printout as needed. “Help” is accessible from any screen within Artstor.

Downloading from Artstor groups into PowerPoint
Artstor makes it possible for you to download image groups directly to PowerPoint. Their “help”
document clearly explains the process
(http://help.artstor.org/wiki/index.php/Export_image_group_to_PowerPoint ). First, create and “save” a
group of images within the Artstor on-line environment. Order and annotate the images in any way that is
meaningful for you, and “save” the group again. In the beige toolbar at the top of the screen, look for the
icon that resembles the “slide show” icon in PowerPoint (a screen with a pull-down ring in the center).
Click there, and follow the directions to download your group to your desktop, and directly into PPT. The
resulting PPT file will have a title screen (white text on a black background) with the name of your group,
and one frame for each image (also on black backgrounds). The text for each image, including your
annotations, will appear in the “notes” box at the bottom of each slide.

Using the Off-line Image Viewer (OIV v3.1.x)
The OIV is a proprietary software package that makes it possible to download locally Artstor’s
large image files (and much of their associated functionality), then to add images from other sources and
make presentations. It is similar to PowerPoint, but is less complicated and has different (some think
better) functionality. The OIV is already loaded onto most computers at IFA; you can download it to your
personal computer as well. The OIV is completely portable.
A note about “personal notes”: Before downloading images from Artstor into the OIV, make
whatever annotations you think you will need in the “personal notes” screen. “Personal notes” download
with the image, but you CANNOT change them once the image has been downloaded to the OIV on your
own computer.
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To download the OIV to your personal computer: after registering as an Artstor user, go to the
“Tools” button at the top of the screen. Click “Download Off-line Presentation Tool,” and follow the onscreen directions. If you have problems downloading the OIV, please contact Joe Rosario in Computer
Services (jr309@nyu.edu). Make sure you download the most recent version of the software, and that
the version you download is compatible with the computer you are using. The downloading instructions
are very clear and easy to follow, but there are some specific systems requirements; the OIV does not
work with all operating systems of all computers. If you have used the OIV before, and have
presentations saved in earlier versions of the software, please note that you will not be able to open OIV
3.1.x files in any earlier version of the software (although 3.1.x does allow you to save a presentation in a
“legacy” format and to open files created with earlier versions of the software).
Once the OIV is installed on your computer, open the program. Your screen will be divided into
three windows (the “Image Palette,” “Slide Sorter,” and “Slide Editor”), and a “Getting Started” dialog box,
giving you several download options, will appear. (N.B.: When working on your home computer with the
OIV for the first time, it is wise to set the image download preference to “medium” so that the downloaded
image files do not crash your hard drive or processor. To do this, close the “Getting Started” box by
clicking the “cancel” button. Go to the “Artstor OIV” tab in the upper left tool bar, and select
“Preferences.” Click the icon titled “Image Size,” and select the radio button for “medium” in the resulting
dialog box. You must close the program and re-open it for any preference change to take effect.)
By selecting the “Create a presentation using Artstor images” option in the “Getting Started”
dialog box, you will be prompted to authenticate yourself to Artstor (e.g., log in), then to tell Artstor which
of your image groups you want to download. The images will download in the order in which you left
them in your on-line image group, directly to your personal computer, into the “Image Palette” window,
along with all their attendant data; any “personal notes” you have made will also download. Please
remember that you must assemble images into a group prior to downloading them into the OIV; the OIV
does not give you direct access to the full Artstor database, just to the image groups you have already set
aside for yourself.
Once an image group has been downloaded to your own computer, you can rearrange the
images, add images from other sources, and present images either as a PowerPoint-like slide show or as
an “Image Palette” slide show. To add images from other sources, pull down the “Insert” menu, and click
the option appropriate to the source of your local images. Tell the OIV where the images are you that
want to add to your image group, and they will appear on the “Image Palette” window, appended to the
group after the most recently selected image, or at the end if no image has been selected. You can also
import a PowerPoint presentation; click the “Import a PowerPoint presentation” button in the “Getting
Started” dialog box, or use that menu option under “Insert” in the main tool bar. PowerPoint presentations
will download as text and image frames into the “Slide Sorter” window, and as images ONLY into the
“Image Palette” window. Please note that although you can open a PowerPoint file in the OIV, you
CANNOT open an OIV file with PowerPoint—it is a one-way function.
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The “Image Palette” window allows you to order images any way you like; select an image (its
frame will turn blue), then drag and drop it wherever you want it. If you want to delete an image, select it
(its frame will turn blue), go to the “Edit” menu, then choose “Remove slide.” NB: If you delete an Artstor
image, and want it back, you will need to return to Artstor to download it again. To annotate your own
images (NOT the images you download from Artstor), select an image (its frame will turn blue), then right
click (in a PC interface; control/click in a Mac interface). Use the “Edit image data” option in the resulting
menu. Right clicking also allows you to rotate or flip an image (this is only possible in the “Image Palette”
window; the changed image can then be used in the “Slide Editor” window.)
Depending on how you want to present the images you have assembled, you can use the OIV in
two completely different ways. There is the “Image Palette” slide show, which is very flexible, but linear.
The biggest advantage to using the “Image Palette” slide show is that the screen can be split either
vertically or horizontally, and zooming and panning features are available in both halves of the screen.
Artstor’s considerable image data can also be called up, in either half of the screen, and the full slide
show, arranged as you last saved it in the “Image Palette,” can be referenced in either section of the
screen. In the upper left of the “Image Palette” toolbar is a small slide icon with a green triangle on it;
click there to preview your slide show.
There is also the “Slide Sorter/Editor” slide show, which works very much like PowerPoint. This
part of the software works in conjunction with the “Image Palette.” Images are held on the “Image
Palette,” then dragged and dropped into the “Slide Editor,” which in turn gives you access to a variety of
pre-set slide templates that make constructing a presentation quick and easy.
In both the “Slide Sorter” and “Slide Editor” window toolbars, there is an icon of a slide with a plus
(+) sign on it. This is the “Add Slide” button. Clicking the “Add Slide” button brings up the OIV’s pre-set
slide template menu. Pick the slide format you need—blank screen, text only screen, 1, 2, 3, or 4
images, with or without text, with or without the zoom and pan features (these templates have a
magnifying glass superimposed on the template mosaic). Selecting a template and clicking “OK” puts
that template into the “Slide Editor.” You can then drag and drop any image from the “Image Palette” into
any part of the template in the “Slide Editor.” Dragging and dropping an image into a text box transfers
the text about that image into the slide template; text can then be added or edited, or removed
completely. Finished slides show in the left frame “Slide Sorter” window, just as they do in PowerPoint.
Slides can be re-arranged (drag and drop), deleted, added, at any point in the sequence of your
presentation, in the “Slide Sorter” window. Deleting images from the “Slide Sorter” or “Slide Editor”
windows does NOT delete them from the “Image Palette,” but deleting an image from the “Image Palette”
removes that image from all three windows—and remember, if you delete an Artstor image from the
“Image Palette,” and want it back, you need to connect to Artstor to download it again.
All slide templates, whether in the “Image Palette” or “Slide Sorter/Editor” version of the OIV
software, are pre-set with a black background. All images will automatically size to fit any template used.
Text is in a pre-set sans serif font, white on black, large enough to be legible from the back row of most
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classrooms. To change any of these pre-set template characteristics, use the toolbar in the “Slide Editor”
window or the “Format” menu options in the main toolbar. The default format settings can also be
changed in the “Preferences” menu (Artstor OIVàPreferencesàSlide Defaults).
Clicking on the slide with the green triangle (“view slide presentation”) takes you directly to
presentation mode. The first screen gives you a list of keyboard shortcut commands, the most important
of which are the spacebar (moves forward one full slide at a time) and spacebar-shift (moves back one
full slide at a time). The right and left cursor keys move your presentation forward or back one element at
a time. That is, if you have 4 images on one screen, tapping the right cursor key in succession will bring
those images up one at a time.
When you have completed editing your slide show, it can be saved to the shared drive on the IFA
network for you to work on later, to a flash or jump drive, to a CD, to your personal hard drive; then
uploaded to any of the classroom computers when you wish to make your presentation. It will remain as
last saved until you open it again. You will NOT need to log on to Artstor to open it (unless you want to
add more Artstor images). The slide show is saved with a .prs file extension. Remember, you CANNOT
open the file in PowerPoint—Artstor’s highest resolution images can only be used in the OIV. If you are
going to take the OIV on the road, it is a good idea to take the software with you (unless the institution
where you are giving your talk is an Artstor subscriber, at which point they should already have the
software available; see http://www.artstor.org/subscribe/s-html/subscribers.shtml for a full list).
Remember when uploading the OIV that the computer you’re using it on must be Java enabled, Flash
updated, and that the pop-up blocker must be turned off if you think you will need to log on to Artstor
directly.
More information about using the OIV can be found under the “help” button in the main OIV
toolbar.

Where to get more help
•

If you want to use Artstor to teach a class, you can arrange instructor-level privileges by
contacting Tom McNulty (tom.mcnulty@nyu.edu), NYU’s primary Artstor administrator, or the
analogous person wherever you happen to be teaching. One thing to bear in mind: because the
licensing entity is the institution at which you are teaching, not you personally, an image group
you set up while registered as an NYU user will NOT be visible to your students at any other
institution, even if you have instructor-level privileges here and there. You will need to have
separate accounts—and separate instructor privileges—at each institution, and you will need to
build image groups from the materials that are locally available and accessible. Contact User
Services at Artstor (userservices@Artstor.org) for assistance moving image groups among
institutional subscriptions. Please note: NYU-hosted images will not move to another institution,
even if the overall group is moved.

Updated January 2014

•

For Artstor’s help pages, see http://help.Artstor.org/wiki/index.php/Main_Page .

•

For general assistance, see Jenni Rodda or anyone on the Visual Resources Collections staff.
Workshops will be taught throughout the year; watch the ifagsa student e-mail list for times and
places.

•

For assistance installing the OIV, see Joe Rosario or George Cintron (joe.rosario@nyu.edu and
george.cintron@nyu.edu respectively).
There is always something new to learn about his software--if you find a particularly nice feature,

please let us know, so we can let everyone else in on the secret! Happy browsing!
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